I3 TEXAS
INSTRUMENTS

Tl Connect™ CE Software

Learn more about Tl Technology through the online help at education.ti.com/eguide.



https://education.ti.com/en/select-country/eguides

Legal Information

Important Information

Texas Instruments makes no warranty, either expressed or implied, including but not
limited to any implied warranties of merchantability and fitness for a particular
purpose, regarding any programs or book materials and makes such materials
available solely on an “as-is” basis.

In no event shall Texas Instruments be liable to anyone for special, collateral,
incidental, or consequential damages in connection with or arising out of the purchase
or use of these materials, and the sole and exclusive liability of Texas Instruments,
regardless of the form of action, shall not exceed the purchase price of this product.
Moreover, Texas Instruments shall not be liable for any claim of any kind whatsoever
against the use of these materials by any other party.

This graphing product application (APP) is licensed. See the terms of the license
agreement.

© 2006 - 2021 Texas Instruments Incorporated

Windows, NT, Microsoft, Apple, and Macintosh are trademarks of their respective
owners.




Contents

What's NeW .. 1
What's New in Tl Connect™ CE Software ... ... .. .. .. .. . .. 1
Introduction to the Tl Connect™ CE Software ... ... ... ._............ 2
Supported Tl Graphing Calculators ... ... .. .. ... 2
Using the Tl Connect™ CE Software ... .. ... ... . ... .............. 3
Parts of the Tl Connect™ CE Software _ ... .. ... .. e 4
Using the Screen Capture Workspace ... ... ... ... ... _............ 6
Parts of the Screen Capture Workspace . ... ... ... 7
Capturing and Using SCreens .. .. ... e 7
Saving Calculator Screens as Files .. ... ... ... i i 8
Dragging and Dropping Screen Captures to Computer Applications ._.._........... 10
Using the Calculator Explorer Workspace ... . ... ... . ... ............. 11
Parts of the Calculator Explorer Main Workspace ... ... . ... . ... . . .... 12
Selecting a Connected Calculator .. ... . . . 13
Copying Calculator Files to the Computer ... ... ... i .. 13
Sending Files to Connected Calculators ....... ... . . it 14
Converting and Sending Background Images ....... ... . ... ... 15
Sending a Background Image to a Connected Calculator ... ... ... ... ........... 16
Data IMpP Ot e 17
Deleting Calculator Files . ... .. .. . 19
Quit Exam Mode Setting on Connected CE Calculators ... .. . ... ... ......... 19
Converting and Sending Python Programs for use in the Python App ... ..._.... 20
Converting a Python Program to a Python AppVar ... . ... ... ... ... .. ...... 20
Which AppVar is a Python AppVar? ... ... 21

Send or Convert a Python AppVar to the Computer (*.8xv or *.py) .............. 21
Using the TI-Basic Program Editor Workspace ... . ... __............ 23
Parts of the TI-Basic Program Editor Workspace ... ... .. . . . . ... .. .. .... 24
Creating a New Program ... ... ... e 26
Editing a Var Name ... 26
Protecting Your Program e 26
Saving a Program to Your Computer .. ... ... 26
Closing @ Program ... ... 27
Using the Catalog Panel ... ... . . . e 28
Using the Syntax Reference Panel .. ... .. .. .. ... 32
HUB menu for Tl-Innovator™ and TI-Innovator™ Rover ... ... .. ... ... .. ........ 32
Sending a TI-Basic Program to a Calculator _. ... .. . . . . . . . . . .. ... ........ 33

i



Maintaining Your Calculator _ ... .. ... ... 35

Updating Your Calculator . ... ... e 35
Getting Calculator Information . ... ... ... ... 38
Compatibility with Graphing Calculators ... ... ... . ... ... 38
General Information ... 39
Online Help .o e 39
Contact Tl SUPPOIt e 39
Service and Warranty Information ... ... ... ... 39
UPateS . . e e 39




What's New
What's New in Tl Connect™ CE Software

Support for Python Enabled CE Calculators
Python (*.py) <--> Python AppVar (*.8xv) Converter

Convert your Python program computer file (*.py) to CE Python AppVar (*.8xv) file and
send to your CE for use in the CE Python App. Python programs (AppVars) created on
your Python enabled calculator can be saved back to your computer as either *.py or
*.8xv files.

See more

Always update with the latest CE Bundle at:

- education.ti.com/84ceupdate

- education.ti.com/84cetupdate
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Introduction to the Tl Connect™ CE Software

The Tl Connect™ CE software makes exchanging information between your graphing
calculator and your computer quick and easy.

Supported Tl Graphing Calculators
Supports any TI-8x graphing calculator with a USB port, which include:

e TI-84 Plus CE Python* and TI-84 Plus CE
e TI-84 Plus CE-T Python Edition* and TI-84 Plus CE-T
e Tl 84 Plus CSilver Edition

e TI-84 Plus

e TI-84PlusT

e TI-83 Premium CE Edition Python and TI-83 Premium CE
e TI-83 Plus.fr

e TI-82 Advanced

e TI-82 Advanced Edition Python with Python82 App

*Note: TI-84 Plus CE family calculators will display as TI-84 Plus CE.

Note: Use Tl Connect™ 4.0 which supports calculators with an 1/0 port only:
e TI-83 Plus

e TI-89 Titanium

e Voyage™ 200

e TI-73 Explorer™

Note: Tl Connect™ CE does not support connectivity with the TI-Nspire™ family.
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Using the Tl Connect™ CE Software

The TI Connect™ CE software contains tools you can use to exchange information
between your calculator and your computer.
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The Tl Connect™ CE software includes three workspaces:
e Screen Capture: allows you to manage screen captures
e Calculator Explorer: allows you to manage calculator content

e Program Editor: allows you to manage Tl Basic programs
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Parts of the Tl Connect™ CE Software

£2 Tl Connect™ CE
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o Menu Bar - Use these menus to manage calculator files and screens to view
calculator information, and to get help.

File Edit View Actions Help

Toolbar - Use these icons to manage computer files and screens.

@ Workspace Panel- Use this panel to select workspaces (Screen Capture,
Calculator Explorer, and Program Editor).

L=l

IE]

6 Calculator List Panel - Use this list to view all connected calculators and to
select one calculator for display.
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TI-84 Plus CE
B e ©

@ Content Panel - Use this panel to view and manage the calculator files and

screen on connected calculator(s).

2 Tl Connect™ CE

File Edit View Actions Help
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Note: You can complete most of the actions in these menus by dragging and

dropping items to your connected calculator or computer.
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Using the Screen Capture Workspace

The Screen Capture workspace allows you to manage calculator screen captures.

£2 Tl Connect™ CE
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Note: Before connecting for a Screen Capture, display the Screen Capture workspace in
view.

Next, connect your calculator to capture the current screen on the calculator.

If a different workspace is in view, such as Calculator Explorer, when the calculator is
connected, the calculator will display the Home Screen. You will have to redisplay the
desired calculator screen for the screen capture.
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Parts of the Screen Capture Workspace

Menu Bar - Use these menus to manage files and images, to view calculator
information, and to get help.

File Edit View Actions Help

Note: You can complete most of the actions in these menus by dragging and
dropping items from the Content Panel.

Toolbar - Click these icons to save, send, copy, delete, and resize files.

Save a file to the computer.

Send a file to a calculator.

Copy a file.

Delete a file.

Add or remove a border from all captured screens.

Change the size of all captured screens.

(N o Nol~ o TN

View the screen capture size.

Content Panel - View screen captures in the Content Panel.
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Capturing and Using Screens

In the Screen Capture workspace, you can capture and view screens from your
calculator.
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Before you Begin

Connect the calculator to the computer and make sure it appears in the Calculator List
Panel.

To Capture Calculator Screens

1. Onthe Tl Connect™ CE software Workspace Panel, click the Screen Capture
workspace.

2. Display the screen on your calculator that you want to capture.

3. Click next to the desired calculator in the Calculator List Panel.

e If more than one calculator is connected, click on next to CONNECTED
CALCULATORS to capture screens from all calculators.

Saving Calculator Screens as Files

The Screen Capture workspace lets you save captured or existing images from your
calculator as a PNG.

*Capture 1 x

1]
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NORMAL

Note: The asterisk at the beginning of an image name indicates that the image is not
saved.

To save an existing screen

1. Click the captured screen in the Content Panel.

2. CIick.

To save multiple screens
1. Click Edit > Select All.

2. CIick.

To rename a screen capture

1. Place your cursor at the beginning of the screen name field.
Ex: Capture 1.

2. Double-click the name to select it.

3. Type in a new name for the computer file.
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To save a new screen capture as a PNG file

1.

5.

Click the image.

Click .

Navigate to a desired save location.

Use the default file name or type a new file name.

.
Click .

To send screen captures to connected calculators

This Screen Capture only feature provides a way to take a screen capture of a graph on
the high resolution calculators, crop to the graph area and then convert only the graph
area to a Background Image. Check Graph Area Only to create this type of Background

Image.
1. If you have not already done so, capture the screen.
2. Click the screen capture to select it.

b

2 Send to Caleulators X

FILE NAME: NAME ON CALCULATOR: LOCATION: ]

Capture 1 Imagel v U

Screen captures and converted image files will be sent as Pic Vars to black and
white calculators

DESTINATION CALCULATORS: [_] Graph Area Only

® All Connected Calculators D Select Calculators

__| Replace existing content with the same name on destination calculators

s (D

FILE NAME: This may differ from the NAME ON CALCULATOR depending on what
you named the screen capture on your computer.

NAME ON CALCULATOR: select the background image (it should be the default, but
you may change the background image name using this menu).

Note: Screen captures and converted image files will be sent as Pic Vars to gray
scale calculators.

GRAPH AREA ONLY: In the right panel, select whether you want to send just the
graph area, or the entire screen. When sending a screen capture back to a
calculator, it is best to send the graph area only.
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Cropping an Image

A screen capture of the graph area includes the full screen of the TI-84 Plus CE,
status bar, graph border, and the graph area.

Tl Connect™ CE software allows you to crop the image to a Graph Area Only size to
create a Background Image Var. You can crop a screen to Graph Area only in the
Send to in the Send to Calculators dialog box.

W

WA (R

.| Graph Area Only | Graph Area Only
e DESTINATION CALCULATORS: Select whether you want to send the image to all
connected calculators, or just selected calculators (from a check list).
To send files to multiple calculators
1. Select the Select Calculators button on the dialog box.
2. Check the boxes to next to the calculators you want to select.
3. Click Send.

Dragging and Dropping Screen Captures to Computer Applications

Using the Screen Capture workspace, you can drag and drop captured screens into
many computer applications. This feature lets you use calculator screens in your
documents.

To drag and drop screens into computer applications
1. Open or capture the screen.

2. Drag and drop the screen to an open document or presentation computer software
application.

Note: You may also use Edit>Copy>Paste into an open document or presenter computer
software application.
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Using the Calculator Explorer Workspace

Calculator Explorer workspace allows you to manage calculator content.
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Parts of the Calculator Explorer Main Workspace

Menu Bar - Use these menus to manage files and images, to view calculator
information, and to get help.

File Edit View Actions Help

Note: You can complete most of the actions in these menus by dragging and
dropping items from the Content Panel.

Toolbar - Click these icons to add, transfer, or delete files from your calculator.

Dﬂ
@]

OO 0 6

Add content from your computer.

Send selected content to your computer.

Send selected content to another connected calculator.

Delete the selected file.

Refresh the view of a connected calculator's contents.

or i~ ol = ®
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Content Panel - Select files you want to manage from this panel.
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Selecting a Connected Calculator

The Tl Connect™ CE software allows you to simultaneously connect multiple
calculators. Click on the calculator you want to work with to select it. The selected
calculator becomes the default calculator for all TI Connect™ CE software actions.

Before you Begin

Connect the calculator to the computer and make sure it appears in the Calculator List
Panel.

Copying Calculator Files to the Computer

You can copy most data, files, and programs from your calculator to your computer as
a content backup, to send to others, or to free up calculator memory.

To copy a file from the calculator to the computer

1. Click on the file name to select it.

2. Drag and drop the file into a folder on your computer or onto your desktop.
To copy a file from the calculator to the computer as a content backup

1. Select Edit

2. Select All

3. Drag and drop the file into a folder on your computer or onto your desktop.
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Note: There is no auto backup feature here.

Warning: Do not disconnect the cable during a transfer.

To copy a file from the computer to the calculator
1. Navigate to the desired file on your computer.
2. Drag the file to the Calculator List Panel and hover over the desired calculator.
3. Release the mouse button when you see * Copy
4

Select a file name from the drop-down menu. This will be the name of the file on
your calculator.

5. Click Send.
Sending Files to Connected Calculators

You can send files to calculators connected to Tl Connect™ CE software.

|Warning: Do not disconnect the cable during a transfer.

To send files to connected calculators
1. Click the file(s) in the Content Panel to select it.

2. Click .

“4 Send to Calculators X

DESTINATION CALCULATORS:

) All Connected Calculators _) Select Calculators
| Replace existing content with the same name on destination calculators

oy -

e DESTINATION CALCULATORS: Select whether you want to send the file to all
connected calculators, or just selected calculators (from a check list).

To send files to select calculators

1. Select the Select Calculators button on the dialog box.

2. Check the boxes next to the calculators you want to select.
3. Click Send.
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Converting and Sending Background Images

The TI-84 Plus CE can display background images and Pic Vars. These variables display
in the graph area.

Note: All information on background images also applies to the TI-84 Plus C Silver
Edition and the TI-83 Premium CE Edition Python.

Working with Background Images

The Tl Connect™ CE software automatically converts any image you send to a
connected calculator into a Background Image Var. Your image may display differently
in the graph area than you expect given the conversion to the pixel dimensions of 83 x
133.

Note: For best results, please edit your image to be proportional to 83 x 133 pixels
prior to the conversion to 83 x 133 pixels.

Tip! Try to convert your image as described below. If the conversion is not as you
expect, scale your picture similar to the graph area where Background Image Vars
are displaying on the CE.

e Take a screen capture of the graph screen at 100% scale using Screen Capture
Workspace. This screen capture can be either in Full or Graph-Table mode. You
will use this to scale your image to a smaller size to fit the size of the graph
area.

e Use a favorite presentation software and display both the screen capture and
your picture.

e Drag (size) your picture to a smaller size and to the proportion of the graph
area.

e Use a snipping tool to snip the new smaller image. Save that image to your
computer.

e Use this smaller, proportional picture to convert to an Image Var following the
next steps below.

Reminder! Preserve your original picture file by using a different computer file
name of your smaller picture.

The conversion to the Background Image Var uses 16-bit color.

You can also convert or upload a Background Image Var into the TI-84 Plus CE emulator
view in TI-SmartView™ CE software.

On the TI-84 Plus CE, a Background Image Var displays as the background in the graph
area only. A background image will display scaled for the MODE screen settings of Full,
Horizontal, and Graph-Table. This preserves any mathematical modeling done on a
background. You cannot edit a background image while working on the TI-84 Plus CE.
Background images run from and are stored in Archive memory.
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Sending a Background Image to a Connected Calculator
You can send a background image and display it in the graph area of the TI-84 Plus CE.

Note: All information on background images also applies to the TI-84 Plus CE-T, TI-84
Plus C Silver Edition, and the TI-83 Premium CE.

NORMAL FLOAT AUTO REAL RADIAN HP l]

Open the Tl Connect™ CE software.

Choose the Calculator Explorer workspace.

Connect the TI-84 Plus CE to the computer using the cable.
Turn on the TI-84 Plus CE.

Choose the image you want to convert.

Drag the picture to the Calculator List Panel and hover over the desired calculator.

Release the mouse button when you see * Copy |

© N Uk wDN R

Select an Image#t name from the drop-down menu (Image0 - Image9). This will be
the name of the image on the TI-84 Plus CE.

Note: The Image# name you choose becomes the image name on your calculator.
Note this Image# name (or make it part of the file name on your computer) for
identification when you want to send or share this file.

WARNING: Pre-loaded images are stored in Imagel - Image5. Use other Image# to
avoid overwriting the pre-loaded images.

9. Click Send.

Note: Rename the computer file so you can identify your Image Var later (bridge,
fountain, etc.) The Image# internal calculator var name will not be changed.

Note: To save the background image to your computer, drag the Image# from the
Calculator Explorer to your desktop or to the folder where you want to save it.

e Todisplay your new background image in the graph area of the TI-84 Plus CE, press
[format] change the Background setting to the Image# you just sent to the
calculator (example: Image5), and press (graph).

Note: From the graph screen on the calculator, you can also change the Background
using [draw]; BACKGROUND; 1:BackgroundOn interactive command.
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Data Import

The Data Import feature lets you convert/send spreadsheet data saved as csv data files
to the calculator as calculator list(s) or matrice(s) files.

Access the Data Import feature from the Calculator Explorer Workspace.
Highlights:
e (Create (or download) a spreadsheet of data.

e Prior to import, edit data in your spreadsheet software to only allowed calculator
numeric formats (specified below) for the import to a calculator file.

About the spreadsheet

e Only one spreadsheet saved as a CSV (Comma Delimited) (*.csv) file will be
imported via Calculator Explorer workspace at a time.

e Spreadsheet (csv) file can be dragged into the Calculator Explorer or imported via
Actions > Import Data (.csv) to List/Matrx... menu.

e Upto 6 calculator lists or 1 matrix from the spreadsheet data will send to the
connected calculator.

Rules for preparing the spreadsheet for import:

e All cells must contain Real Number data as experienced on the calculator and no
text.

- Complex numbers are not supported for data import.

- If decimal numbers are represented with the use of a comma in the *.csv file,
the file will not convert using the Data Import Wizard. Please check your
computer operating system number formatting and convert the *.csv to use the
decimal point representation. The calculator list and matrix editor use the
number format as, for example, 12.34 and not 12,34.

e Data must start in cell Al

Using the Calculator Explorer Workspace 17



List(s) Import: If calculator lists are desired:

£2 Import your Data b

Prior to importing your spreadsheet saved in csv file format, make sure
your data starts in cell A1, contains only Real numeric values, and does
not contain text.

Select calculator file type for conversion

FILENAME: total.csv

COLUMNS:

{~} Lists v 1 v

CANCEL CONTINUE

- Only six spreadsheet columns A-F will be imported

- Columns can be of length up to 999 cells.

- The first empty cell in a column will be interpreted as the end of the data for
that list import

Matrix Import: if calculator matrix is desired:

£2 Import your Data X

Prior to importing your spreadsheet saved in csv file format, make sure
your data starts in cell A1, contains only Real numeric values, and does
not contain text

Select calculator file type for conversion:

FILENAME: total.csv

[:] Matrix v 2 x|2 a

CANCEL CONTINUE

- Only one matrix can be imported from a spreadsheet file.

- Upto 400 cells can be imported. (Example: row x col: 10 x 5 = 50 cells from
row range 1-10, columns A-E.)

- Dimension of matrix of the form (row x column) will be requested during the
import experience in Calculator Explorer.

- Any empty cell within the specified matrix dimension will be interpreted as 0.

Do not have data in the spreadsheet outside of the allowed sizes for list(s) or
matrix as described above. Otherwise, the file will be invalid when a data import
to Calculator Explorer is attempted.

18
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To save calculator list(s) or matrix files

e To save calculator files created to the computer, after import/send to calculator,
drag the list(s) or matrix file from Calculator Explorer to the desired computer
location.

Deleting Calculator Files
You can delete data, files, and programs from your calculator.

To delete files from the calculator

1. Click on the file in the Content Panel you want to delete.

2. Press .

Quit Exam Mode Setting on Connected CE Calculators

Quit the exam mode setting on your CE by connecting CE calculator(s) to the computer
and selecting

e Actions > Quit Exam Mode on Connected CE Calculators in TlI Connect™ CE.
Always update with the latest CE Bundle at:

- education.ti.com/84ceupdate

- education.ti.com/84cetupdate
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Converting and Sending Python Programs for use in the Python App
Converting a Python Program to a Python AppVar

When a CE calculator supports Python programming a Python program (*.py) from your
computer will convert to a Python AppVar (*.8xv) when you send the file to your CE
calculator with Python or CE caluclator using Tl Connect™ CE. Then, using the
appropriate Python App for your calculator, you will be able to edit and run your Python
program.

Reminder: For any computer/TI-Python experience: After creating a Python program in
a Python development environment on the computer, please validate your program
runs on the calculator/emulator in the TI-Python experience. Modify the program as
needed.

See Python App e-Guide for details on TI-Python.

When you send your *.py program file(s) using Send to Calculators, the action is similar
to sending any other file to the calculator.

&2 send to Calculators &2 Name on Calculator X
FILE NAME: NAME ON CALCULATOR: LOCATION: Custom AppVar Python names can be up to 8 characters
- R in length.
Python01.py PYTHONO1 | RAM v
m The first character can be A-Z.
The remaining characters can be A-Z, _or 0-9.
DESTINATION CALCULATORS: Custom
®) All Connected Calculators O Select Calculators
] Replace existing content with the same name on destination calculators
CANCEL

I
FILE NAME: Displays the computer file name of your *.py file(s).

Note: This may differ from the NAME ON CALCULATOR depending on what you
named the Python program on your computer.

NAME ON CALCULATOR:

e If the computer file name follows the Python AppVar naming rules, then the Python
AppVar calculator name populates with the computer file name. Naming rules are
shown on the screen above.

- Lower case will automatically change to upper case letters.

e If the computer file name does not follow the Python AppVar naming rules, then
the NAME ON CALCULATOR populates with PYTHONO1, PYTHONO?2, etc.

e Change the NAME ON CALCULATOR using the Custom naming option in the pull
down. You must follow the naming rules for the Python AppVar.

LOCATION:

e Choose to send the Python AppVar to the calculator’s RAM or Archive memory.
- The default is RAM.
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- The Python App will only edit and run Python AppVars in RAM.
e Store Python AppVars in Archive memory on the calculator when you
- do not have enough memory in the Python App experience as stated in the App.

- do not wish to see the Python AppVars load into the Python experience until a
later time when you move them from Archive to RAM on the calculator.

Note: To move a Python AppVar between RAM and Archive memory on your CE
Press [mem] 2:Mem Management/Delete... > B:Var App...
Press [enter] on each AppVar to toggle from RAM to Archive (denoted by *).
DESTINATION CALCULATORS:

> Select whether you want to send the program to all connected calculators, or just
selected calculators (from a check list).

Which AppVar is a Python AppVar?
You will be able to identify your Python AppVars as follows.

In TI Connect CE Calculator Explorer, the Python AppVar will display as “AppVar
Python.” Here, SCRIPT1 and VABSOLUE are Python AppVars.

& GRAPH AppVar Python
e HELLO AppVar Python
g LINREGR AppVar Python

Note: The Python AppVar will send to other 8x family calculators but will not be
accessible on those calculators.

Press [mem] 2:Mem Management/Delete... > B:Var App... will display PY at the
right of the screen.

[NORMAL FLOAT AUTO REAL RADIAN HP n

RAM FREE 148459

ARC FREE 1321K

» GRAPH 995 PY
HELLO 278 PY
*KEYS88G 523 PY
LINREGR 662 PY
*PRINT 67 PY
PYTHONB1 143 PY
*ROVER 382 PY
*SALEPRC 235 PY

Send or Convert a Python AppVar to the Computer (*.8xv or *.py)

You can send a Python AppVar from your calculator to your computer as a Python
AppVar (*.8xv) or as a Python program (*.py).

e Send to computer as Python AppVar only: Drag a Python AppVar from a connected
CE calculator with Python will send to the computer as an AppVar (*.8xv) file.

e Send to computer with option to send as a Python program (*.py):
- Select a Python AppVar in Calculator Explorer. Example: AIRECARR
- Select Actions>Send to Computer
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- Select either the AppVar (*.8xv) or Python (*.py) extension when saving to your
computer.

| HELLO.8xv

AppVar Python (*.8xv)

Python (*.py)

Note:

- After converting a Python AppVar back to a *.py computer file, please check
the syntax, spacing, line breaks, and Python specific items in your computer
Python software. Make necessary modifications specific to the version of
Python you are using on the computer. Python versions vary.

- When saving the conversion to *.py back to your computer, it is best to save
the program to a new *.py name on your computer to avoid overwriting
your original *.py program.

Reminder: For any computer/TI-Python experience: After creating a Python program in
a Python development environment on the computer, please validate your program
runs on the calculator/emulator in the TI-Python experience. Modify the program as
needed.

See Python App e-Guide for details on TI-Python.
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Using the TI-Basic Program Editor Workspace

The TI-Basic Program Editor Workspace allows you to work with Tl Basic programs.

£2 T Connect™ CE

File Edit  View  Actions Help

New Program

_|_

Open Program

u
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Parts of the TI-Basic Program Editor Workspace

2 T Connect™ CE

File Edit View Actions Help

- New Program
Open Program

o

o Menu Bar - Use these menus to manage files and programs, and to get help.

File Edit View Actions Help

Note: In the Program Editor Workspace, you can only drag and drop
programs to the Content Panel.

e Toolbar - Click these icons to Create new program, Open program, Save
program to computer, Send program to connected calculator(s), Undo, or Redo
and Font Size Slider.

+ @B 8 9o e A
o0 6 o e (6]

Create new program.

Open program.

Save program to computer.

[~ ol

Send program to connected calculator(s).
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® Undo or Redo.

® Font Size Slider to increase or decrease the size of text in:
e (Catalog Panel
e Program Editor

(3]

Content Panel - Use this panel to create, view, and edit programs.

New Program

_I_

Open Program

-

Catalog Panel - Use this panel to select your calculator type and then choose
from the catalog tree list (by category) to create programs.

» Angle

» Catalog

* Char

*» Distribution
» Draw

* Finance

» Format
»List

» Math

» Matrix

* Memory

* Mode

> Program

» Statistics
» Stat Plots
* Table Setup
» Test

> Variables

» Zoom
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@ Syntax Reference Panel - Use this panel to view the proper syntax of each
command along with required and optional arguments.

x Reference

AsnConp (prgmASM1, pragn/

Creating a New Program

When no programs are open, the Content Panel displays only the New Program and
Open Program icons.

To create a new program New Program

» Click the New Program icon. _|_

To open an existing program

Open Program

1. Click the Open Program icon. —

2. Navigate to the appropriate folder. -
3. Click Open.

Editing a Var Name

New program names are PROG##. The numbers run in sequence, ex: PROGO01,
PROGO2.

To change the program name

» Click inside the Var Name box and type in a new name up to 8 letters or numbers
(first cannot be a number.)

VAR NAME:  PROGO1

Protecting Your Program

Tl Connect™ CE software allows you to protect your program from being edited after
the program is sent to a connected calculator.

To protect your program

»  Click the check box next to the lock icon. H
Saving a Program to Your Computer

The asterisk at the beginning of a program name indicates that the program is not
saved.
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To save a program

1. CIick.

2. Navigate to the appropriate folder.

3. Click Save.
Closing a Program
To close a program

» Click the x by the program name.

Using the TI-Basic Program Editor Workspace
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Using the Catalog Panel

The Catalog Panel contains a list of calculator commands, functions, variables, and
symbols you can use to create programs.

To expand or collapse a Catalog level

» Click the triangle beside each Catalog entry.

TI-84 Plus CE ~ *Untitled1.8xp X

» Keypad

» Angle VAR NAME:  PROGO7
» Catalog

» Char

Distribution
Draw

>
»
» Finance
»
»

Format
List
¥ Math
» Math
» Numeric
» Complex
» Probability
¥ Fraction
I
4D
rnid4rUnid
» Matrix
» Memory
» Mode
» Progran

» Statistics
» Stat Plots
» Table Setup
» Test

» Variables

» Zoom

Synt .eference

No reference available

To place a Catalog entry in the Content Panel

» Drag and drop the Catalog entry into the Content Panel. This places the cursor in
the program editor command line after the item is dropped.

-OR-
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» Double-click the Catalog entry. This pastes the item to the program editor and the
focus remains in the Catalog Panel to select another item. Click back at the end of
the command line to continue typing in the editor.

To avoid Syntax errors

Use the catalog of commands and symbols to paste to the editor to avoid syntax errors
due to the incorrect use of upper and lower case in commands.

Example:
Did you type Eval( or eval(?

Did you type sin( or Sin(?

The catalog
tree list pastes | TI-84 Plus CE ~ *Untitled1.Bxp X
the correct
case and DispGraph

space DispTable VAR NAME: | PROGO1
formatting. »DMS
Dot-Thick
Dot-Thin
DrawF

l 281 eval{

Drawlnv
DS<(

e

=

E

MEFF(
El=s
End

Eng
EqurString(
eval (
ExecLib
expr(
ExpReg
Exproff
Expron
Fcdf (

% Reference

Brtimme n ctrdinn

Extra Space Syntax Errors
Running a Program on a Calculator

Extra spaces can cause a Syntax error when a program is runs on the calculator.
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Where are the extra spaces?

You can see extra spaces in your
program using Tl Connect™ CE Program
Editor by selecting the entire program.
Extra spaces at the end of command
lines should be deleted prior to sending
the program to the calculator.

VARNAME: SNAKE

| )
A+26 ( (A=) - ( -2fn*
1@ 1

When the program runs in the calculator, if there are extra spaces, selecting Goto from
the syntax error screen will place the cursor on the program line where the error
occurred. Check the line for correct syntax and extra spaces at the end of the command
line.

VARNAME:  SNAKE

URMAL FLOAT AUTA REAL RADIAN MP n
([PROGRAM LINE 11

ERROR: SYNTAX

ClrHome

1:Quit

13-A
548
124X
1+P
3440

: Xedin(L1)
:X+dim(L1) Xadin (L2)
:X>dim(L2) i L”

(F111(B,L1)

PTG LaP). )
*Repeat KE45S theputted 1o

/] BaL1 (P)
5 AsLz(P)
/ P+1-X(P=X)~P
& tKey-K
Cursor lands on error. 3 o (ke(24,25,26,34})
K+D

A+ (D=26)- (D=24) +A
B+(D=34)- (D=25)-B
A+26( (A=B) - (A=27) )-A
B+1@((B=0)-(B=11))+B
End

e Move cursor to the end of that command line.

e Carefully delete extra spaces.

Note: There is no undo on the calculator.
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WORFAL FLOAT AUTO REAL EADIAN HF n HORRAL FLOAT AUTO KEAL RABIAN riF n

PROGRAM : SNAKE

:ClrHome :ClrHome
:12+A :13+A
15+B 1548
1104X P10
1P 1P Spaces
1340 134D
) | Xsdim(Lall i¥edimils)  H
iXrdimilz) s rdimilz}
tFil11(B.L1} tF11liB.L1)

When Do Commands Become Calculator Commands (Tokens)?

The commands do not become calculator commands (tokens) until the program is sent
to the calculator.

If there is an error when your program sends to the calculator or runs on the calculator,
check to see if every command in the calculator program edit mode is actually a
command token.

How Do You Know?

When a command is a token on the calculator, the cursor will be on the first character
and then jump over the command as a token. If the cursor moves letter-by-letter
through a command, that command did not get converted. Delete and paste the
command from the calculator.

. PROGRAM: B PROGRAM: B On the calculator, the cursor
) :EnvBinom( :invBinom(H

jumps over the “token.”

It only understands the
characters as a function or

command name.

Reminder: When entering a program directly on the calculator, the command or
function pastes completely as a token.

Warning: Some calculator commands such as LEFT, CENTER, RIGHT, FRAC, are words
you might use in a string. If a word you use in a string is the same as a calculator
command, your word will become a calculator token and may give errors in your
program. Avoid using words or parts of words that are the same as a Tl-Basic
command to avoid unintentional tokenization to a command.

Warning: The language setting of Tl Connect™ CE determines how the text is
interpreted as a command token for the calculator. Opening programs and sending
back to the calculator with Tl Connect™ CE in different languages may result in:

e undesired command tokens and/or

* syntax errors
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Using the Syntax Reference Panel

The Syntax Reference Panel displays the syntax of each Catalog entry, including
required and optional arguments.

Syntax Reference

Pt-Change(x,y[,color#])

HUB menu for TiI-Innovator™ and TI-Innovator™ Rover

Program Editor supports the TI-Innovator™ HUB menu for TI-Innovator™ and TI-
Innovator™ Rover commands. The HUB menu is located in the Program menu in the
catalog tree. This HUB menu addition to the Tl Connect™ CE Program Editor is the
same HUB menu experience as when the Hub App is loaded on the CE calculator.
Please always use the latest versions of the CE OS and CE Hub App.

Note: If the Program Editor HUB menu does not contain some of the latest HUB
commands, please type in the commands in the Program Editor as needed.

Always update with the latest CE Bundle at:

- education.ti.com/84ceupdate

- education.ti.com/84cetupdate

See Also:
Using the Catalog Panel ¥ Pragram
¢ Comtrol
Sending a TI-Basic Program » Input/Output
to a Calculator » Colar
* HUE
» Sond["SET

¥ Send( "READ

¥ Settings
Wait
Get |
eval |

» Rover [(RV)...

®# Sond | "CONNECT-Output

Send| "CONNECT- Input

Forts

» Sond| "RANGE

» Send ([ "AVERAGE

* Send| "DISCONMECT -Output

* Send| "DISCOMMNECT-Input

» Hanage
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Sending a TI-Basic Program to a Calculator
You can send a program to a connected calculator.

To send a program to a connected calculator

1. If you have not already done so, save the program.

N
2. CIick.

® FILE NAME: This may differ from the NAME ON CALCULATOR depending on what
you named the program on your computer.

e NAME ON CALCULATOR: select the program name (it should be the default, but you
may change the program name by clicking Custom).

= Name on Calculator ‘ = e S|

2 Send o Calaulators x

AL Nave NAME ON CALCULATOR: LocaTion:
UNESKD Lne v RAM v
Custom Program names can be up to 8 characters in length

The first character can be A-Z or 8.
The remaining characters can be A-Z, 8 or 0-9

DESTINATION CALCULATORS: Custom

All Connected Calculators ® select Calculators

Replace existing content with the same name on destination calculators

CANCEL

* LOCATION: Choose whether you save the program in the calculator's RAM or
Archive.

e DESTINATION CALCULATORS: Select whether you want to send the program to all
connected calculators, or just selected calculators (from a check list).

To send programs to multiple calculators

1. Select the Select Calculators button on the dialog box.

2. Check the boxes to next to the calculators you want to select.
3. Click Send.

Language Settings

If you wish to develop a TI-Basic program in a language different than your computer
OS language setting, you can re-launch Tl Connect™ CE in another language.

1. Select File > Change Language.

2. Select the language change after restart of the application.
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#2 Choose a language X

Language changes will take effect after application restart.

English (US) v

CANCEL QUIT LATER QUIT NOW

e QUIT LATER - Retains the language selected and Tl Connect™ CE will launch in this
selected language the next time Tl Connect™ CE is launched.

e QUIT NOW - Closes the software app. TI Connect™ CE will launch in this selected
language the next time Tl Connect™ CE is launched.

e CANCEL - No language change. Computer OS language will be the default.
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Maintaining Your Calculator
Updating Your Calculator

Tl CE Bundle file — use one computer file to update your CE calculator!

Update your connected CE calculator(s) in one step using Tl Connect™ CE and the TI CE
Bundle.

Always update with the latest CE Bundle at:

- education.ti.com/84ceupdate

- education.ti.com/84cetupdate

Connect your CE calculator(s) to Tl Connect™ CE. Drag the appropriate Tl CE Bundle to
Calculator Explorer.

Tl Connect™ CE will update your CE OS, any CE Apps that need to be updated or are
missing from your calculator(s) and also load the 5 pre-loaded Image Vars to Imagel —
Image5. The process cannot be stopped so make sure to save off (drag off) any of your
favorite calculator files using TI Connect™ CE Calculator Explorer. You can drag your
favorite calculator files back to your calculator after the new TI CE Bundle process
completes.

Drag the CE Bundle to Calculator Explorer. Please wait until the complete process
finishes. Do not pull the cable during any file transfer. Expect the CE calculator to
reboot prior to the Image Var and Apps transfer. Expect the CE calculator to
defragment (rearrange memory) at some time during the process. Messages display
when transfers take place on the TI Connect CE window.

Note: The Tl CE Bundle contains all the latest files you need to update or restore your
CE calculator(s) as though you just bought your calculator and provides a fast way to
update your class set

CE calculator(s).

Important: If the CE calculator screen says "Waiting..." the calculator has lost the OS.
This can happen if a cable is pulled from the calculator or computer during a file
transfer. If connected, disconnect and reconnect the CE to the computer. Drag the CE
Bundle to Calculator Explorer.

Reminder: Wait until the complete process finishes. Do not pull the cable during any
file transfer. Expect the CE calculator to reboot prior to the Image Var and Apps
transfer. Expect the CE calculator to defragment (rearrange memory) at some time
during the process. Messages display when transfers take place on the Tl Connect™ CE
window.

You may repeat this process and the CE Bundle will transfer the files again. Do not pull
the cable during any file transfer.

See Also:

Sending Files to Connected Calculators
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Updating TI-84 Plus CE Calculators

Tl Connect™ CE software lets you download operating systems for graphing calculators.
Before you begin

e Backup your calculator files.

e Make sure your calculator is turned on and securely connected to the computer.

e If you have multiple calculators connected with USB computer cables, OS transfers
can occur to specific calculators.

This can be done by selecting the specific calculators in the Send dialog.

Warning: Do not disconnect the cable during a transfer.

To update graphing calculator operating systems
1. Click Actions > Send OS.

2. Navigate to the correct OS file for your model of calculator stored on your
computer.

3. Click Open..

The Send OS dialog box opens.

2 send 0S X

Os File:
TI84Plus_05.8Xu

WARNING: Sending the OS will clear the memory on the destination calculators,
but archived items (apps. background images, etc.) will not be erased. Do you want
to send the OS now?

DESTINATION CALCULATORS:

) All Connected Calculators ®) Select Calculators

V| T1-84 Plus-D658

[¥) T1-84 Plus Silver Edition-CEBS

| Replace existing content with the same name on destination calculators

CANCEL SEND

4. Select from Destination Calculators:
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DESTINATION CALCULATORS:

0 All Connected Calculators (® Select Calculators
/] TI-84 Plus-D658

/] TI-84 Plus Silver Edition-CEBS

5. Press Send e
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Getting Calculator Information

Tl Connect™ CE software allows you to get information about your calculator's type,
product ID, OS Version, RAM, Archive, Language, ROM Version, and Hardware Version.

Note: Calculator Information is available only from the Calculator Explorer
Workspace.

Note: The TI-84 Plus CE family will display as TI-84 Plus CE. See all supported TI-84
Plus CE in the Supported Tl Graphing Calculators section.

To view calculator information

» Click View > Calculator Information.

=2 Calculator Information x

Calculator: TI-84 Plus C
Product ID:

_____ 0S5 Version:
RAM:

Archive:

Language:

ROM Version:

Hardware Version:

CLOSE

Compatibility with Graphing Calculators

Please refer to the TI-84 Plus CE Getting Started Guide for compatibility with graphing
calculators.

Apps, Operating Systems and some data files with unsupported numeric types do not
share between models.

TI-Basic programs may need to be modified to correctly display on the higher
resolution color screen models.
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General Information
Online Help

education.ti.com/eguide

Select your country for more product information.

Contact Tl Support

education.ti.com/ti-cares

Select your country for technical and other support resources.
Service and Warranty Information

education.ti.com/warranty

Select your country for information about the length and terms of the warranty or
about product service.

Limited Warranty. This warranty does not affect your statutory rights.
Updates

education.ti.com/84ceupdate

education.ti.com/84cetupdate
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